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Overview

System Requirements

The Test Generator is a completely web-based application which requires the following:

• a high-speed internet connection
• a modern web browser (see below)

Basic Terminology
• All content related to a particular textbook is referred to as a product. 

• A product is comprised of multiple question sets and/or tests. 

• Each question set or test is comprised of multiple questions.

• Multiple questions can be linked to a single table, chart, picture, or passage. This shared item is 
known as a preface.

The test generator window is organized into three parts:

• Question Sets Pane: The Question Sets pane displays your question sets in a folder structure. 
Question sets are typically organized by textbook chapters or units. 

• Tests Pane: The Tests pane displays your tests in a folder structure. 

Windows

• Google Chrome 21+
• Mozilla Firefox 17+
• Microsoft Internet Explorer 9+

Macintosh

• Apple Safari 5.1+
• Google Chrome 21+
• Mozilla Firefox 17+
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• Editor Pane: Open a question set or test in the editor pane on the right to view/select questions 
or to make changes to it. You can edit existing questions, add or delete questions, change 
formatting, select questions to add to a test/set, and print from the editor pane.

Question Sets Versus Tests
Content may be stored as question sets or tests. Question sets and tests are similarly organized and may 
be edited interchangeably. Publishers provide content as question sets, which are often organized by 
textbook chapter or topic area. You can use the questions in these question sets to build tests for your 
students. You can also create your own question sets and questions.There is no limit to the number of 
questions that may be stored in a question set or used in a test.

Opening a Question Set
You can browse and edit a question set. You can open an existing question set in the following ways.

• Right-click a question set and choose the Open Question Set option from the menu that appears.
• Click a question set and then choose Open Question Set from the Options menu.
• Drag the question set you wish to open from the Question Sets pane to the editor pane.

Navigation and View Settings
When viewing a question set or test, you can choose how many questions to view per page in your 
browser. Viewing fewer questions per page helps each page load more quickly in your browser and 
requires you to scroll less. The view settings do not have any impact on pagination for printed sets/tests.

To change the view settings:

1. Use the View drop-down list to select how many questions to display on your browser page.

2. Use the Go to drop-down list to navigate to a particular range of question numbers.

You can change the default view settings in your profile.
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Editing a Question
Use the following steps to edit an existing question.

1. Select the question set or test and select Open from the Options menu.

2. Click the question you want to edit.

3. Click the pencil icon that appears to the left of the question, and choose the Edit option. You can 
also double-click a question to open it.

4. Edit the question, answer, and question information as desired. When you are finished, click OK.

Saving Tests or Question Sets
Because tests and question sets are automatically saved in real time, you don’t need a save button. When 
you click OK while editing a question, the question is saved to the database. If a sudden network outage 
or power outage occurs, simply log in again and the test or question set will be just as you left it.

Question Types
The test generator offers the following question types:

• True/False: Question with an answer of either true or false. 
• Modified True/False: Question with an answer of either true or false. If the answer is false, 

students must also provide a word or phrase to make the statement true.
• Yes/No: Question with an answer of either yes or no.
• Multiple Choice: Students choose one correct answer from the choices provided.
• Multiple Response: Students choose one or more correct answers from the choices provided.
• Numeric Response: Question with a numeric answer.
• Completion: Question with a one-word or short phrase answer.
• Multi-blank: A completion question with multiple blanks.
• Matching: Students match questions to appropriate answer choices.
• Objective Short Answer: Question with a text answer that can be automatically graded.
• Subjective Short Answer: Question with a text answer that cannot be automatically graded.
• Multi-Mode: Question that can toggle between multiple choice, objective short answer, and 

subjective short answer. Toggling questions enables you to quickly and easily change the difficulty 
level of a test.

• Ordering: Students must put answer choices in the correct order.
• Opinion Scale/Likert: Students rate their agreement with a statement.
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• Drag and Drop: Flexible question type that allows you to create interactive labeling and matching 
activities without programming.

• Bin Sort: Questions allow you to create interactive sorting and matching activities where multiple 
items can go in the same bin.

• Interactive (HTML5): Question that allows for rich internet content in HTML5. 
• Essay: Question with an answer in paragraph form. Rubrics can be associated with essay 

questions

Online Help
In addition to this guide, context-sensitive help is available throughout the system. When you click the 
Help button, you will receive help specific to the task you’re performing. Think of the help as your online 
user guide.
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Unit 1: True/False, Yes/No, Multiple Choice, and Multiple Response 
Questions
In this unit, you will learn how to create the most basic types of questions. These include true/false, yes/
no, multiple choice, and multiple response questions. These question types form the basis for the other 
more complex questions and may account for a large portion of the questions you write.

After completing this unit, you will be able to:

• Add question text to a true/false or yes/no question
• Specify the correct answer a question
• Add specific feedback for the correct and incorrect answers
• Write multiple choice questions
• Write multiple response questions
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Preview: Creating True/False and Yes/No Questions
True/false and yes/no questions are the most basic questions, offering students only two choices. These 
questions are useful for simple identification, and they are easy to write. True/false questions are 
declarative sentences. Yes/no questions are questions. Below is an example of true/false question on a 
printed test and an example of an online test.
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Module 1: Creating the Question Text
Use the following steps to create the text of a true/false question.

1. Click the New Question button. 

2. Choose True/False or Yes/No in the Question Type Selection dialog box.

3. Enter a question title in the Title field. Adding a question title allows authors and instructors to 
find a question in the Question Sets pane without opening the question set.

4. Enter the question content in the word processor window.

5. Select the correct answer from the 
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6. Answer drop-down list.

Try It

In your practice question set, create a new true/false question based on the following information.

Solution

Module 2: Adding Feedback on the Extra Tab
If an online test is set to provide feedback, then Cognero can notify students if they are right or wrong. 
You can also provide more detailed feedback for the student. 

To add detailed feedback:

1. Click the Extra tab.

2. Click the Edit link for the feedback you want to edit.

Question title: Matter

Question text: Matter is anything that has mass and takes up space.

Correct answer: True

../../../../../Cognero Test Generator Core Curriculum/True False (Feedback).png
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3. Enter the feedback text.

4. Click Update.

Try It

• Add the following text as the incorrect feedback: Matter is anything that has mass and takes up 
space.

• Click OK to add the question to the question set.

Practice: True and False Questions
In our practice question set, create a true/false question based on the following information. Use the rich 
text editor to emphasize the word “definite” in the feedback.

Note: You can use the rich text editor to add formatting or to include hyperlinks in your 
feedback.

Question title: Substance

Question text: A substance is matter that has an indefinite and uniform 
composition

Correct answer: False

Correct feedback: A substance has a definite and uniform composition.

Incorrect feedback: A substance has a definite composition.
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Solution
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Preview: Creating Multiple Choice Questions
With multiple choice questions you can allow students to select one answer from a list of choices. 

Module 3: Creating the Question Text
Creating the question text for a multiple choice question is similar to creating true/false and yes/no 
questions but with a few extra options.

To create a multiple choice question:

1. Click the New Question button. 

2. Choose Multiple Choice in the Question Type Selection dialog box.

3. Enter a question title in the Title field.

4. Enter the question content in the word processor window.
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5. Enter the answer choices in the table provided.

6. Select the correct answer from the Answer drop-down list.

Try It

In your practice question set, create a new multiple choice question based on the following information.

Question title: Weight

Question text: The measure of the earth's gravitational pull on matter is:

a. Mass

b. Weight

c. Atomic weight

d. B and C

Correct answer: b
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Solution
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Module 4: Setting the Number of Choices and Columns
When creating a true/false or yes/no question, you only have two possible answers. With a multiple 
choice question, you can have up to 26 options (a-z). Because of that, you may want to control how the 
choices are displayed. You can use the Number of choices field to specify how many choices there are. 
Use the Number of columns field to define how the choices are arranged. You can have a maximum of 
four columns.

Try It

• Change the number of choices to 5.
• Add the following as a new choice: All of the above.
• Change the number of columns to 2.

Module 5: Setting the Scramble Options
In the test generator, you can scramble the order of questions within sets and tests and even scramble the 
choices within individual questions. This allows you to write a question once and then scramble the 
choices to generate multiple versions of a test to prevent cheating. When using online testing, it is 
possible for each student’s test to have a unique order of questions and question responses.

If you use variables when writing questions, it’s also possible for students to receive unique content as 
well. See the algorithmic training for more information on variables.

You can use the following scramble options:

Try It

• Change Scramble capable to a-c.
• Click OK to add the question to the question set.

All: If this option is selected, all answer choices for this question will be 
scrambled if the instructor chooses to scramble the test.

None: If this option is selected no answer choices for this question will be 
scrambled if the instructor chooses to scramble the test.

A-?: If this option is selected, some but not all answer choices for this question 
will be scrambled if the instructor chooses to scramble the test.

For example, choose A-C if choice D is “none of the above.” This will allow 
the first three choices to be scrambled while maintaining choice D.
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Module 6: Creating Multiple Response Questions
For a multiple response question, students must identify one or more correct answers from the list of 
choices provided. 

The steps for creating a multiple response question are the same as creating a multiple choice question, 
with one distinction. When creating a multiple response question, you indicate the correct answers by 
typing the letters for the correct responses in the Answer field and separating them with commas. 

 

Caution: Do NOT use spaces between the commas.
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Try It

In your practice question set, create a new multiple response question using the following information.

Solution

Module 7: Writing Feedback for Multiple Choice and Multiple Response Questions
For true/false and yes/no questions, you can write feedback for the correct and incorrect responses. For 
multiple choice and multiple response questions, you can write feedback that is specific to each answer 
choice. Regardless of the question type, you can use rich text to include formatted text, tables, images, 
and hyperlinks in the feedback.

Question title: Weight and Mass

Question text: Weight measures the:

a. Amount of matter in an object

b. Effect of the gravitational pull on matter

c. State of the matter

Correct answer: a,b
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Practice: Multiple Choice and Multiple Response Questions
In your practice question set, create questions based on the following information.

Question type: Multiple choice

Question title: Hypothesis

Question text: A testable statement or prediction is a:

a. Hypothesis

b. Theory 

c. Scientific law

Correct answer: a

Question type: Multiple response

Question title: Scientific Method

Question text: Which of the following are parts of the scientific method?

a. Hypothesis

b. Theory

c. Experimentation

d. Voting

Correct answer: a,b,c
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Solution
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Unit 2: Entering Question Information 
Each question may be tagged with question information such as difficulty levels, state standards, 
keywords, and much more. This question information may be used to help create filters when selecting 
questions for a test, used to sort questions, and used in post-test results reporting. The following 
summarizes how the different question information can be used.

Sort Tests Reports

Points x   

Rubric   x

Rationale   x

Difficulty x x  

Reference x x x

Learning Objectives x x x

Accreditation Standards  x x

Common Core x x

National standards  x x

State standards  x x

Local standards  x x

Corporate standards  x x

Topic x x  

Search Keywords x x  

Notes x   

Other x   
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After completing this unit, you will be able to add the following information to questions:

• A difficulty rating 
• A topic reference 
• A page or chapter reference 
• Search keywords 
• Learning objectives 
• National, state, local, corporate, or accrediting standards 
• A rationale 
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Module 1: Accessing Question Information
The majority of the question information is available on the Info tab in the question dialog box. Rationale 
has its own tab within the Question dialog box.

To access question information:

1. Edit or create a new question.

2. Click the Info tab.

3. Click the Info and Objectives button.

Try It

Create a new question using the information below.

Question type: Multiple choice
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Module 2: Adding Question Information

Adding Difficulty, Topic, and Search Keywords
The Difficulty, Topic, and Search Keywords can all be used by instructors to sort questions and build tests. 
For example, you could sort questions in a test so that easier questions are first and the more difficult 
ones are last. You could also build a test based on a specific topic.

To add a difficulty level, a topic, or keyword entry:

1. Click the Add Record link and enter your data. 

2. Then click the Update link to record your entry. 

Question title: Control

Question text: In an experiment, a standard for comparison is a: 

a. Control

b. Independent variable

c. Dependent variable

Correct answer: A
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3. Click the Add Record link again to add additional records in the same field.

4. Click the Edit link to edit existing records.

Try It

Using the question you just added:

• Add Easy as the Difficulty.
• Add Data Analysis as the Topic.
• Add Control as a Search keyword.

Adding References 
You can use the Reference field to indicate a unit, chapter, section, or page number where information 
related to the question can be found. The reference information can be used to sort questions, build 
tests, and build reports. The process for adding a reference is the same as adding difficulty, topics, and 
keywords.

Try It

Using the same question you have been editing:

• Add Page 25 as the Reference.

Learning Objectives
You can use learning objectives to tie test questions to specific instructional goals. The learning objectives 
can be used to sort questions, build tests, and build reports. You add a learning objective the same way 
you would add data to any field that allows separate records. The main difference is that learning 
objectives have two parts: an objective ID and a description. The objective ID must be unique. Therefore, 
you can’t use the same objective ID number for objectives in different products. For example, if you have 
an objective ID of 1-1 for an economics product you cannot have an objective ID of 1-1 in an English 
literature product. Below are examples of correct and incorrect ways to handle learning objective IDs.

Caution: When creating publisher content, the IDs and descriptions will usually already 
be established. Therefore, when working with publisher content, you should just add 
or delete learning objective IDs to questions. You should never edit the learning 
objective description.

If the wrong learning objective is associated with a question, delete that learning 
objective from the question. Then, add a new record and enter the correct learning 
objective ID.
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Correct

Incorrect

Try It

Using the same question you have been editing, add the following as a learning objective:

Adding Standards
You could add national, state, local, corporate, or accrediting standards to a question. The standards can 
be used to build tests and build reports. You can format the standards using the rich text editor. The 
Standard ID, like the Objective ID, must be unique.

Try It

Using the same question you have been editing, add the following as a state standard. Use the state 
abbreviation for your state in the State/Region field.

Adding Common Core Standards
Each question can also be tagged with Common Core State Standards (CCSS). These standards are added 
through a special dialog box.

To add Common Core State Standards to a question:

1. Edit the question to which you want to add a Common Core standard.

2. Click the Info tab.

3. Click the Info and Objectives button.

Objective ID Description

ALGB.15.1.1 Calculate the slope of a line

ENGL.15.1.1 Explain the elements of Native American mythology

Objective ID Description

1.1 Calculate the slope of a line

1.1 Explain the elements of Native American mythology

Note: You can also format the objectives using the rich text editor to apply formatting and 
include hyperlinks.

Chem 1.1 Define variables to design an experiment.

M1.1 Use algebraic and geometric representations to describe and compare data.
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4. In the Common Core section, click the Add Record link and enter your data. The Manage 
Common Core Standards dialog box opens.   

5. Select a subject from the Subject list.

6. Select a grade level from the Grade list.

7. Expand the topics to view individual standards.

8. Click the  button to read the description of a standard.

9. Select a standard and click Add to the add the Standards Added To This Question list.

10. Repeat the steps 7-9 to add multiple standards.

11. Use the Delete link to delete unwanted standards.

12. Click OK to add the standards to the question.

Adding Notes and Other Information
Cognero also provides two fields that allow you to save additional information about a question, the 
Notes and Other fields. These fields cannot be used to sort questions or to create tests or reports.

The Notes field allows for multiple records like the objectives and standards fields. The Other field is a 
free form text field like the Rationale field.
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Adding a Rationale
The Rationale tab allows you to enter the reasoning behind a question. When a question is part of an 
online test, instructors can choose to display the rationale for students after they complete the 
assignment.

Try it

Add the following text to the Rationale tab: “A control is held constant or removed to measure the effects 
of other variables.”
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Module 3: Displaying Question Information
When a question has question information, you can view in the editor pane when you open question sets 
and tests.

To display question information:

1. Open a question set or test by dragging it to the editor pane.

2. Choose Display Question Information from the Set or Test menu.

3. Use the check boxes to select which question information to display. 

4. Check all / Uncheck all option to select or clear all check boxes. 
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Question information includes:

5. Click OK to apply your selections.

Module 4: Accessing Question Information as a Publisher
In publisher mode, you can use the Edit Info feature to quickly edit question information for a question in 
a question set without opening the Edit Question dialog box. You can also use the Edit Question 
Information option from the Set menu to edit all the question information for a question set from a single 
dialog box. These options are available only for publisher users.

Answer State/regional standards Custom IDs
Rationale Local standards Question IDs
Feedback Accrediting standards Distractor information
Points Corporate standards Question type
Difficulty Topics Preface name
Reference Search keywords Variable status
Learning objectives Notes Student entry mode
Common Core standards Other notes Global IDs
National standards Create and modified dates 

Note: Only the fields with data display. 

Note: Question information is displayed for the instructor only. It does not display for 
students in printed or online tests.
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Editing the Question Information for a Single Question
You can bypass the word processor window and go directly the Question Information dialog box.

To edit question information for a single question:

1. Open a question set.

2. Click the question.

3. Click the pencil icon.

4. Choose Edit Info.

5. The Question Information dialog box opens.

6. Edit the question information and click OK.

Editing Question Information for an Entire Question Set
Use the edit question information feature to quickly edit question information for all questions in a 
question set. This option is available only for publisher users.

To edit question information:

1. Open a question set by dragging it to the editor pane.

2. Choose Edit Question Information from the Set menu.

3. Click the question ID of the question for which you want to edit information.

4. Choose the information field you want to edit from the Displayed information list.

5. Add, edit, or delete information as desired.
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6. Repeat steps 3 through 5 for all questions you want to edit.

7. Click the OK button when you are finished editing question information.

Practice: Question Information
In your practice question set, create a multiple response question, with question information, based on 
the following information.

 

Question title: Model

Question text: A model is a: 

a. Visual explanation of experimental data

b. Verbal explanation of experimental data

c. Mathematical explanation of experimental data

d. Hypothetical explanation of experimental data

Correct answer: a,b,c

Difficulty: Easy

Reference: Chapter 1

Objective: Chem 1.2, Predict and explain the electronic and molecular 
structures of common substances using models.

Keyword: Model
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